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and grammar check – Word count – Thesaurus - Auto correct  - Working with  tables – Saving, 

opening and closing documents – Mail merge. 

UNIT - III Introduction to MS Excel and its features – Programmes and applications -  spread 

sheets – Building worksheets – Entering data, editing and formatting worksheets – Creating 

and formatting different types of charts – Application of financial and statistical function – 

Organising data using Automatic rule saving, opening and closing of work books. 

UNIT - IV Fundamentals of computerized accounting – computerized accounting Vs manual 

accounts. Architecture and customization of TALLY – Features of Tally- Configuration of 

Tally screens and menus – Creation of company and groups – Editing and deleting ledgers – 

Introduction to vouchers – Entry, payment, receipt, sales, purchase, contract and Journal 

vouchers- Editing and deleting vouchers. 
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UNIT-1 

COMPUTER APPLICATIONS IN BUSINESS 

 

Computer -Commonly Operated Machine Particularly Used for Trade, 

Education and Research. The word computer is a Latin word. It means “to 

reckon” or “to compute”. It takes the input converted in output. 

DEFINE:  

 A computer is an electronic machine that can store and deal with large amount of information. 

MEANING OF COMPUTER: 

A computer is a machine or device that performs processes, calculations and operations based on 

instructions provided by a software or hardware program. It has the ability to accept data (input), 

process it, and then produce outputs. 

CHARACTERISTICS OF A COMPUTER 

1. Speed: A computer is a very fast device capable of data processing at 

unbelievable speed. It can perform in a few seconds the amount of work that a 

human being may not be able to do in an entire year even if he works day and 

night and does nothing else. Computers can process millions of instructions per 

second thus carrying out even the complex tasks in fractions of seconds without 

any mistake. 

 

2.Accuracy: In addition to speed, the computer has high accuracy in computing. 

The accuracy of a computer is consistently high and the degree of accuracy of a 

particular computer depends upon its design. But for a particular computer, each 

and every calculation is performed with the same accuracy. Errors can occur in a 

computer, but these are mainly due to human rather than technological weakness. 

 

3.Versatility: A computer is a very versatile machine. Versatility is one of the most 

wonderful features of the computer in the sense that they are not only capable of 

handling complex arithmetical problems, but can do equally well other number of 

jobs. 

 

4.Diligency: Unlike human beings, a computer is free from monotony, tiredness, 

lack of concentration etc. and hence can work for hours together without creating 

any error and without grumbling. Due to this property computers obviously score 

over human beings in doing routine type of jobs, which require greater accuracy. 

 

5.Storage Capability: Computers have their main memory and auxiliary memory 

systems. A computer can store a large amount of data. With more and more 

auxiliary storage devices, which are capable of storing huge amounts of data, the 

storage capacity of a computer is virtually unlimited. 

 

 

 

 



 

Components of computer: 
(a) Input/Output Unit 

(b)Central Processing Unit 

(c) Memory Unit 

 

 

  
 

a.Input/Output Unit 

 We know that the computer is a machine that processes the input data according to given set of 

instructions and gives the output.  

 The Input Unit is used to enter data and instructions into a computer. The most common form of 

input device is known as a terminal. A terminal has a electronic typewriter like device, called 

keyboard along with a display screen, monitor.  

Keyboard is the main input device while monitor can be considered both as an input as well as an 

output device. There are some other common input devices like mouse, joystick, scanner, modem 

etc.,  

Monitor, printer and plotter are the main peripheral devices used as output units for the computer. 

 

b.Central Processing Unit 

 Central Processing Unit (CPU) is the main component or "brain" of a computer, which performs all 

the processing of input data. Its function is to fetch, examine and then execute the instructions stored 

in main memory of computer. 

  
1. Arithmetic Logic Unit (ALU): 

 The arithmetic and logic unit of CPU is responsible for all arithmetic operations like addition, 

subtraction, multiplication and division as well as logical operations such as less than, equal to and 

greater than. Actually, all calculations and comparisons are performed in the arithmetic logic unit. 

 



 

2. Control Unit (CU): 

 The control unit is responsible for controlling the transfer of data and instructions among other units 

of computer. It is considered as a "Central Nervous System" of computer, as it manages and 

coordinates all the units of computer.  

 

3. Registers: 

 Registers are the small high speed circuits (memory locations) which are used to store data, 

instructions and memory addresses (memory location numbers), when ALU performs arithmetic and 

logical operations. Registers can store one word of data (1 word = 2 bytes & 1 byte = 8 bit. 

4. Buses: 

 Data is stored as a unit of eight bits (BIT stands for Binary Digit i.e. (0 or 1) in a register. Each bit 

is transferred from one register to another by means of a separate wire. This group of eight wires, 

which is used as a common way to transfer data between registers is known as a bus.  

5. Clock: 

 Clock is another important component of CPU, which measures and allocates a fixed time slot for 

processing each and every micro-operation (smallest functional operation).  

c.Memory Unit 

 This is unit in which data and instructions given to computer as well as results given by computer 

are stored. Unit of memory is "Byte".1 Byte = 8 Bits 

It is of following three types: 

 (a) Read Only Memory (ROM pronounced as “Ra-om”) 

 (b) Random Access Memory (RAM pronounced as "R-aem") 

 (c) Complementary Metal Oxide Semiconductor Memory (CMOS) 

 

i.Read only memory(ROM): Read-only memory (ROM) is a type of storage medium that 

permanently stores data on personal computers (PCs) and other electronic devices. ROM is read-

only, it cannot be changed; it is permanent and non-volatile, meaning it also holds its memory even 

when power is removed.  

ii. Random Access Memory (RAM):RAM, also known as volatile memory, stores data regarding 

frequently accessed programs and processes. (It's called volatile memory because it gets erased 

every time the computer restarts.) 

iii.Complementary Metal Oxide Semiconductor Memory (CMOS):It is a technology used to 

produce integrated circuits. CMOS circuits are found in several types of electronic components, 

including microprocessors, batteries, and digital camera image sensors. 

 

 

INPUT & OUTPUT DEVICES 
Input/Output devices are listed in table below. 

 

 
 

Input Devices : This unit makes link between 

user and computer. The input devices translate 

the information into the form understandable by 

computer. 

1.Keyboard- The most common and very popular input device which helps in inputting data to the 

computer 

Input Devices Output Devices 

Keyboard Monitor 

Mouse LCD 

Joystick Printer 

Scanner Plotter 

Light Pen  

  

  

              Touch Screen  

https://techterms.com/definition/integratedcircuit
https://techterms.com/definition/processor
https://techterms.com/definition/digitalcamera


 

 

2.Mouse- Mouse is the most popular pointing device and cursor-control device having a small palm 

size box with a round ball at its base which senses the movement of mouse and sends corresponding 

signals to CPU when the mouse buttons are pressed. 

 

3.Joy Stick- The joystick is a vertical stick which moves the graphic cursor in a direction the 

stick is moved. It typically has a button on top that is used to select the option pointed by 

the cursor. Joystick is used as an input device primarily used with video games, training 

simulators and controlling robots. 

 

4.Light pen- It is a pen shaped device used to select objects on a display screen. It is quite 

like the mouse (in its functionality) but uses a light pen to move the pointer and select any 

object on the screen by pointing to the object. 

 

5. Bar codes:A bar code is a set of lines of different thicknesses that represent a number. Bar 

Code Readers are used to input data from bar codes. Most products in shops have bar codes on 

them.Bar code readers work by shining a beam of light on the lines that make up the bar code 

and detecting the amount of light that is reflected back. 

 

6.Scanner- A scanner allows you to scan printed material and convert it into a file format that may 

be used within the PC.  

7.Digital camera:A digital camera can store many more pictures than an ordinary camera. 

Pictures taken using a digital camera are stored inside its memory and can be transferred to a 

computer by connecting the camera to it. A digital camera takes pictures by converting the 

light passing through the lens at the front into a digital image. 

 
 

8.Touch Screen:It allows the user to operate/make selections by simply touching the display 

screen. Common examples of touch screen include information bank ATMs 

 



 

 

Output Devices: 
output device is any piece of computer hardware equipment which converts information into 

human-readable form. it can be text, graphics, tactile, audio, and video.some of the output devices 

are visual display units (vdu) i.e. a monitor, printer, graphic output devices[1], plotters, speakers etc. 

1.Monitor:Monitor is an output device that resembles the television screen and uses a Cathode 

Ray Tube (CRT) to display information. The monitor is associated with a keyboard for manual 

input of characters and displays the information as it is keyed in. It also displays the program 

or application output. Like the television, monitors are also available in different sizes. 

 

2.Printer: Printer is an output device, which is used to print information on paper. 

There are two types of printers − 

Impact Printers: Impact printers use the typewriting printing mechanism wherein a hammer 

strikes the paper through a ribbon in order to produce output. 

 

Non-Impact Printers: Non-impact printers do not touch the paper while printing. They use 

chemical, heat or electrical signals to etch the symbols on paper. Inkjet, Deskjet, Laser, 

Thermal printers fall under this category of printers. 

 

3.plotters:Plotters are used to print graphical output on paper. It interprets computer commands 

and makes line drawings on paper using multicolored automated pens. It is capable of producing 

graphs, drawings, charts, maps etc. 

https://en.wikipedia.org/wiki/Computer_hardware
https://en.wikipedia.org/wiki/Text_display
https://en.wikipedia.org/wiki/Computer_graphics
https://en.wikipedia.org/wiki/Haptic_technology
https://en.wikipedia.org/wiki/Audio_signal
https://en.wikipedia.org/wiki/Video
https://en.wikipedia.org/wiki/Computer_monitor
https://en.wikipedia.org/wiki/Printer_(computing)
https://en.wikipedia.org/wiki/Output_device#cite_note-1
https://en.wikipedia.org/wiki/Plotter
https://en.wikipedia.org/wiki/Computer_speakers


 

 

4. Headphones: Headphones output audio from a computer through two individual headphones for 

a single listener. Also known as earphones, headphones allow you to listen to audio without 

disrupting other people. 

 

5.Computer Speaker: Computer speakers are hardware devices that transform the signal from the 

computer's sound card into audio. Speakers create sound using internal amplifiers that vibrate at 

different frequencies according to data from the computer. This produces sound. 

 

HARD WARE AND SOFTWARE IN OPERATING SYSTEM 

MEANING OF HARDWARE: 

hardware includes the Physical features, which are every part that you can either see or touch, for 

example: monitor, camera, keyboard, mouse, and printer. 

Operating System 

Operating system is defined as a system software that manages computer hardware and software 

resources and provides common services for computer programs. All application software computer 

programs require an operating system to function. Operating system controls computer's hardware, 

run the computer's programs and organizes files.fornex:CPU 

Hardware Components 

Computer hardware is a collection of several components working together. Some parts are essential and 

others are added advantages. Computer hardware is made up of CPU and peripherals as shown in 

image below. 

 

 

http://www.physics.org/article-questions.asp?id=54


 

Software 

A set of instructions that drives computer to do stipulated tasks is called a program. Software instructions 

are programmed in a computer language, translated into machine language, and executed by 

computer. Software can be categorized into two types − 

 System software 

 Application software 

1.System Software 

System software operates directly on hardware devices of computer. It provides a platform to run an 

application. It provides and supports user functionality. Examples of system software include 

operating systems such as Windows, Linux, Unix, etc. 

2.Application Software: 

An application software is designed for benefit of users to perform one or more tasks. Examples of 

application software include Microsoft Word, Excel, PowerPoint, Oracle, etc. 

 

Difference between Hardware and Software 

 

It is the physical unit of computer. it is the collection of programs used 

to 

operate the hardware components. 

It consists of electronic components. It consists of numerals, alphabets, 

special 

symbols, signs, etc. 

It works with binary codes. It is represented by high level 
languages. 

It can understand only machine level or 

assembly level language. 

It is written in high level language 

which 

readable by human beings. 

It is classified into input unit, output 

unit, 

CPU. 

It is classified into operating 

system, utilities, 

and application programs. 
 

 

 



 

 

 

 

How to Create a New Folder on Your Computer 

 To create a new folder in the Documents library: 

1. Choose Start→Documents.  

The Documents library opens. 

2. Click the New Folder button in the command bar. 

An icon for the new folder appears in the content area, with the name New folder next to it, already selected. 

 

 
3.Type the name you intend to give to the new folder. 

Don’t move the cursor or mouse before you start typing. Your new text will replace the highlighted text 

automatically. 

4.Press the Enter key to make the new name stick. 

 



 

 

 

 

AREAS OF APPLICATION: 

• Accounting 

• Banking 

• Medical 

• Education 

• Designing 

• Transport 

• Communication 

• Engineering 

• Entertainment 

• Insurance 

• Cinema 

Accounting: 

Computers are used to maintain accounts efficiently. We can easily take the reports like trail 

balance, profit and loss account, and balance sheet. It can also do Inventory management , 

financial management , and cash management. 

Banking: 

Nowadays all banks are computerized. Computer transactions are maintained by 

computers. In this way computer helps to improve the services of banks. ATM is used for 

cash withdrawals and deposits. 

Medical: 

In hospitals, computers are used to maintain patient details, their diseases, and treatments 

given by the doctors. Most of the equipment’s are computer controlled like Scanning, X-rays. 

Education: 

Computers can be used in education to teach students. It is used to create “virtual class rooms” and “virtual 

university”. Students can get most of the details using various websites available in the internet. 

Designing: 

In every business used to draw designs. By using AutoCad software , Engineers draw the blue prints of their 

proposed buildings. 

Transport: 

In railways, it is used for reservation and cancellation of tickets in an easy manner. By this method people can 

book their tickets from anywhere in the country. Airways and shipping corporation use computers in their day-to-

day activities. 

Communication: 

E-mail, voice mail and video conferencing are possible by usingcomputers. It can control telephone and 

communication also. 



 

 

 

 

Engineering: 

Computer aided manufacturing software is used by the engineers to design new products before their 

manufacturer. 

Entertainment: 

Computers are used to play movies and to play games. 

Insurance: 

Insurance companies use computer to maintain their policyholder details. 

Cinema: 

Computers are used for adding graphical effects in films. 

WINDOWS 2007 

Windows 7 is an operating system that was produced by Microsoft and released as part of the 

Windows NT family of operating systems. It was released to manufacturing on July 22, 2009, 

and became generally available on October 22, that year. 

Features of windows 2007 

Simple 

Windows 7 makes it easier to search and use information, including local, network and 

Internet search functions. The intuitive user experience will be more advanced. It also 

integrates automated application submission and cross-program data transparency. 

Efficiency 

In Windows 7, the search function of system integration is very powerful. As long as the user 

opens the start menu and starts to input the search contents, the search function can run 

automatically regardless of the application, text documents, etc., 

Gadget 

Windows 7 gadgets don't have sidebars like Windows Vista, and they are placed on the 

desktop alone, which is convenient and easy to use. 

Efficient search box 

The search box of Windows Explorer of Windows 7 is on the right side of the menu bar, 

which can adjust the width flexible. It can quickly search documents, pictures, programs, etc. 

in Windows. 

 

https://en.wikipedia.org/wiki/Operating_system
https://en.wikipedia.org/wiki/Microsoft
https://en.wikipedia.org/wiki/Windows_NT
https://en.wikipedia.org/wiki/Software_release_life_cycle#Release_to_manufacturing_(RTM)


 

 

 

 

LOGGING ON: 

In network environment, the workstation should be connected to the server computer to get 

the various resources available in the server. This process is called “logging on”. 

For this connection the user working in workstation must give the user name and the user 

working in workstation must give the user name and password. 

DESKTOP AND TAKBAR: 

Desktop is a work area on the screen, on which we see various icons and the application 

windows, which are in state. 

• Short cut icons 

• Taskbar 

• Start button 

• Time & status 

 

ICONS ON DESKTOP: 

The opening screen of window 98/95 is called as desktop. The desktop was a several icon 

Icons are the small pictures or images representing application. Each icon has a label tells the 

name of the application it represent. 

Icon classified as; 

❖  Application icon 

❖  Group icon 

❖  Programme item icon 

Programme Icon: 

It represents the application icons, which are in the desktop. 

❖  My computer 

❖  Network Neighbourhood 

❖  Recycle bin 

❖  My documents 

❖  Internet Explorer 

STARTUP MENU OPTION: 

The start menu acts as a launch pad for most of the things we want to do with windows 98. 

➢  Shutdown: This option is used to shut the computer operation. 

➢  Logoff: This option is used to logout the current user from server. 

➢  Run: This option is used to execute the programs stored in the computer system 



 

 

 

 

➢  Help:This option give some tips to use windows 98. 

➢  Find: This option is used to search the location of a given file. 

➢  Settings: This option is used to change the default settings. 

➢  Documents: This used to list the recently used file names. 

➢  Favourites: This option gives favourite website names. 
➢  Programs:This option displays the list of application programs available in 

the system. 
 

CREATION OF FILES AND FOLDERS 

Folders: 

Folder is a kind of file that contains a list of other files. 

 

Files: 

A file is a collection of related information. 

 

Folder Creation In Desktop 

1. Right click in any empty area on desktop. 
2. Choose “New”. 
3. Choose “folder” in the submenu of “New”. 

           File Creation on A Folder In Desktop 

i. Double click the folder. A “New folder” window appears. 

ii. In “New folder” window , choose “File” 

iii. Choose “New” 

iv. Choose “Microsoft word document” 

v. Type the content of the file. 

vi. Save the file. 

WINDOWS EXPLORER 

It is a file-folder manipulating program. 

Uses of windows Explorer: 

i. It is possible to create files and folders. 
ii. Deleting, copying files and folders are very simple when using windows explorer. 

iii. We can execute the applications directly by double clicking that applications. 
iv. We can create shortcut icon for an execution file. 
v. The status bar shows the total number of objects on the right pane and their sizes. 

vi. The status bar also shows the free space in each drive. 

FIND OPTION 

It is used to search a particular folder, sub folder or file in the hard disk of a computer. A file 

can be searched by 

1. Name 



 

 

 

 

2. Date 

3. Size 

4. File type 

 

Steps for Find Process: 

i. Click “start” button. 

ii. Click “Find” option. 

iii. Click “Files and Folders”. 

iv. Type the file name and look in directory. 

v. Click “Find now” option. 

vi. If the matching files are found. 

vii. If there are no such files, message “The file not found” will be displayed. 

 

SHORTCUTS 

Shortcut is used to create two or more logical places for the same file. 

Creation of shortcuts: 

i. Right click on desktop’s free area. 

ii. Select “New” 

iii. Click “Shortcut”. 

iv. Type the location of the execution file or find the location using “Browse”. 

v. Click “Next”. 

vi. Enter the name of the shortcut icon. 

vii. Choose the symbol for the shortcut icon. 

viii. Click “Finish”. A shortcut icon will be created on the desktop. 

 

BRIEFCASE 

It is a folder containing files and folders that can move between desktop computer and a 

laptop computer. 

Creation of Briefcase: 

i. Right click on desktop free area. 

ii. Select “New”. 

iii. Click “Briefcase”. 

 

A Briefcase icon is created. 

RUNNING APPLICATION 

The following methods are used to run applications. 

1. By using Windows Explorer. We can select the application and then 

double click that application. 

2. By using shortcut icon on the desktop. 

3. By using “start/programs” options. 

4. By using “Run” option in the start menu. 



 

 

 

 

 

CUSTOMIZATION 

Changing the default setting of windows 98 is called customization. Some of the 

customization activities are 

 

i. Changing background 

ii. Creating shortcut icons 

iii. Resizing taskbar 

iv. Moving taskbar 

 

********* 

  

 

 

 

                                                                                

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

                                                                                 UNIT-2  

                                                            INTRODCTION TO MS-WORD 

Microsoft Word Components              

Before you get started with Microsoft Word , you will need to locate and open it from the computer. It 

may be on your desktop. 

Step 1: Click the Start button 

 
Step 2: Click the All Programs option 

 
 

 

 

 

 



 

 

 

 

Step 3: Search for Microsoft Office 

 
 

Step 4: Search for Microsoft Word 

2010 

 

 
 



 

 

 

 

 

 

The word document will be open 

 

 

 
 

 

This is an image of the upper-left corner 

of MS Word. 

 



 

 

 

 

This box features two important bits of 

information: which file you are currently 

working on (in this case, “Document 1” 

since we have not yet renamed it) and 

which program you are using (in this 

case, “Microsoft Word.”) 

 

This box shows a blinking cursor, 

ready for your commands. 

 

 

 

 

Using the Browser’s Toolbar 
 

This is a close-up view of the Title Bar, where file information is located. Notice the three buttons on the 

right side, controlling program features. Remember that the X button on the far right means close the 

program, the middle button is a toggle switch between full screen and a small window, and the single line 

button on the left means minimize to the task bar 
The Menu Bar 

 

The Menu Bar is a common sight in almost all Microsoft Windows programs. It features text-based menus, on 

which are listed virtually every option. Each menu expands when clicked (with the left mouse button), offering 

many options categorized by specific tasks. 

You can click on each of the words to see a menu of the tasks you can perform. 

To see a menu: 

1. Point with your mouse to a menu option 

2. Click the left mouse button once to open a drop-down menu 

3. Point with your mouse to a particular item 

4. Click once with the left mouse button to select the item 

 

 

                                                



 

 

 

 

The Standard Toolbar  

Toolbars provide “shortcuts” to commands also found in the Menu Bar. Toolbars are  usually located just 

below the Menu Bar, and exist to offer another way to perform the sam

COPY 

PRINT PREVIEW NEW 

SPELL CHECK PRINT OPEN 

PASTE CUT SAVE 



 

 

 

 

The Formatting Toolbar 

 

The Formatting Toolbar offers options that can change the font, size, color,alignment, organization and style of 

the text in the document. For example, (starting from the left side of the Toolbar) the “Normal” setting 

dictates the STYLE of your text; the “Times New Roman” indicates the FONT of your text; the “12” indicates 

the SIZE of your text; and so on. 

 

 

Finally,  

RULLER 

The ruler is generally found below the main toolbars. The ruler tells you where you are on the page, along with 

the dimensions of the overall document. Just like a real-world piece of paper, the default setting is 8.5 x 11 

inches, and margins have been incorporated for you. 

Similar to most options in MS Word, this is entirely customizable and the user can create documents of any 

dimension. 

Typing Text 

 

To enter text, type just as you would if you were using a typewriter. 

To capitalize a letter, hold down the SHIFT key while typing the letter. 

Or, press the CAPS LOCK key on the left hand side of your keyboard. You will have to press the CAPS LOCK key 

again – once you are done capitalizing – to remove the lock. 

You do not need to press ENTER to start a new line – Microsoft Word will automatically wrap your sentence at 

the end of the line. 

To move the cursor from its position at the end of your sentence to anywhere else on the page, use the mouse  

or the arrow keys to move the cursor where you want the 

This is  sentence  features many  SIZES. 

 

The “B” will make your text BOLD, the “I” will put it in italics, and 

the “U” will add an underline to your text. 

To the LEFT, 

In the CENTER, 

And to the RIGHT. 



 

 

 

 

letters or spaces to be (left-click the mouse to place the cursor) and then type what you want to add — the 

text will adjust to include it. 

 

Press ENTER to start a new paragraph (this is sometimes called a “carriage return”).  

Formatting Text 

Changing the look of what you’ve written is called “formatting”. This can include changing the text style, size, 

color, and more. 

You can also make bold, underline, or italicize when using MS Word. These 

features do not have to be used independently of each other either – in other words, you can make bold, 

underline, and italicize a single piece of t ext. 

To make text really stand out, you can also combine this with alignment and size to produce a heading in bold, 

italics, underlined, sized and centered: 

Sale at Bob’s Paint Supplies 

 

Deleting Text 

 

While typing a document, you may make a mistake. Unlike a typewriter, MS Word can delete text on the 

screen. 

A common source of confusion for users is understanding the difference between the “Delete” key and the 

“Backspace” key  the “Backspace” key deletes words to the LEFT of the cursor, and the “Delete” key de- letes 

words to the RIGHT of the cursor. 

This is my awe | some sentence. 

 

BACKSPACE DELETE 

Let’s assume that the vertical line dissecting the word “awesome” in the example above is our cursor. Pressing 

the “Backspace” key will erase “e,” “w,” “a” and so on, moving LEFT. The “Delete” key will erase “s,” “o,” “m,” 

and so on, moving RIGHT. 

Don’t forget 

about the 

special 

function keys 

on your 

keyboard! 



 

 

 

 

Undo and Redo 

 

 

The UNDO and REDO features of Microsoft Windows applications are great tools to rely on (especially in MS 

Word). The program will keep a list of the last 25 commands that you have performed, and it will allow for 

taking “one step” backwards in order to erase what you have just done. 

It is a common thought that life itself should have an UNDO feature. ☺ 

1. Click ►Edit ►Undo from the Menu Bar to go back one step (up to 25) 

2. Click ►Edit ►Redo from the Menu Bar to go forward one step (up to 25) 

Copying, Cutting, and Pasting Text 

 

In MS Word, you can CUT or COPY text from one area of the document and save that text so it can be PASTED 

elsewhere in the document. 

When you CUT text, you actually delete it from where you took it, as opposed to COPYING it, which makes, 

naturally, a carbon copy of your selection. 

To CUT a selection, first highlight it. Then, click ►Edit ►Cut from the Menu Bar. The highlighted text will 

disappear, as you have just cut it out and MS Word is waiting for you to paste it somewhere else. 

To PASTE this cut selection somewhere else on the page, place your cursor where you want the selection to 

go. Click ►Edit ►Paste from the menu bar, and it will pop into place, right where your cursor is. 

To COPY, simply follow those same steps, replacing the CUT command with COPY. You will notice immediately 

that the COPY command will not alter your original selection at all, as it is simply making a copy of it. 

Spelling and Grammar Check   

 

 

MS Word has utilities that can check your spelling and grammar against a master database, and can offer 

advice on a variety of different grammatical styles. 

MS Word automatically underlines any words that it does not recognize in red, assuming that they are not 

spelled right, and green if it does not recognize the grammar, assuming that the sentence does not make 

logical sense. For example:The dogs is always black. 

In this case, “dogs is” should read “dogs are” and “blac” should be “black.” If you right- click on the word, a 

menu will pop up with options, including “Ignore” if you do not want help on this specific phrase. 

Saving the docment 

 



 

 

 

 

When you finish typing and want to leave the computer, it is important to save your work. 

 

Click ►File ►Save from the Menu Bar to get started. 

 

You can change the filename that Word has chosen just by typing a new one in the File name box at the 

bottom of the window that appears. 

 

 

 

 

 

 

 

 

 

MS Word will automatically save your document . 

There are many places in which you can save a file, some of  

To bring a saved document back up on the screen from MS Word: 

Click ►File ►Open from the Menu Bar. 

Locate where the file is located (which folder, that is) and click on the filename of the document you want.

  

Printing Documents 

To print your MS Word document: 

Click ►File ►Print from the Menu Bar and a Print window will pop up on the screen. Click ►OK for your 

document to start printing. 

 From the Print menu, you can alter how many copies will be made, in what order the pages will be and much 

more. 

Another useful tool is the Print Preview function found alongside the Print command. This will allow you to 

look over an exact copy of what will come out of the printer before actually executing the print command. 

CREATION OF BUSINESS LETTER 



 

 

 

 

 

 

  

 



 

 

 

 

MAIL MERGE FO  MS-WORD 

MEANING: 

It is a feature available in MS-Wrod to create the same type of letter to be sent to many recipients at different 

locations. 

Steps for mail merge 

Step.1 open a word document type the letter 

Step.2click mailings in the tools menu –type a new list 

 

 

Step-3click customize column delete the unwanted column 

 

 

 

 

 

 



 

 

 

 

Step-4 enter the information of title, name finished means ok and also save the file   

  

Step-5 next click select recipients –men open click existing list –save file open with document  

 

 



 

 

 

 

Step-6 click insert merge one by one enter 

 

 

Step-7 click preview result-click finish &merge menu are open click edit individual-all-ok 
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